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Assigning Attributes to Geometry: Overview
Welcome to the Assigning Attributes to Geometry User's Guide. This guide is intended for users who need to become quickly familiar with the Attributes functions and dictionaries in Digital Project.

A Brief Introduction to Attributes
Definition: Digital Project Attributes are fields of structured data within the 3D model that may describe or quantify virtually any • • • geometry part product

Attributes can be implemented as either packages attached to geometry or as objects that appear in the tree and can be shared among a number of other objects. Definition: An Attribute Package is a collection of attributes that are all applied and managed together. An attribute package is attached to existing geometry. Definition: A Group is a feature created in the specification tree that can inherently have attributes. A group provides an intelligent collection of features, so the features in one may share its attributes. Attribute Package Definition Group Definition
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Being able to manipulate attributes provides you with one of the most powerful features of Digital Project. Among many other things, you can use groups for: • • • • • • Grouping objects and associating information to the grouping for any collaboration purpose Design and construction coordination Issue management Linking to external systems such as Primavera Effectively tracking approval cycles Coordinating 3D models with the written specifications

You can turn geometry into intelligent objects for Building Information Modeling (BIM) by attaching packages for : • • • • • • • Uniformat specifications MasterFormat specifications Door and window schedules Finish information Material information Safety information ...and much more
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Attribute Packages and Groups
The image below illustrates attaching an attribute package 04200 Masonry Units to the body BASEMENTWALL_1. The package and its attribute Spec Number will enhance BASEMENTWALL_1 with information. Attaching an Attribute Package to an Object

In comparison, if we create a group that has attributes such as below in the Group Attributes frame of the dialog box, those attributes will be shared by all the objects we add to the group : BASEMENTWALL_1, BASEMENTWALL_2, EXTERIORWALL_CORE, etc. Adding Objects to a Group with Attributes
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Attribute Dictionaries
Definition: An Attribute Dictionary is a file that contains the definitions of packages and groups and the attributes within them and how they are organized and applied. Attribute dictionaries are extensible: while Digital Project delivers some attribute packages and dictionaries with the software, you can customize and augment these dictionaries, and even create entirely new dictionaries.
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Assigning Attributes to Geometry: Overview menu on the left.

The selected item in next drop-down menu to the right is the active attribute package or group (in this case, All Attributes is an attribute package).
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Selecting the Current Dictionary
A dictionary contains the definition of attributes, attribute packages, and groups. Only the current dictionary is active at any one time. This task shows you how to change the current dictionary. 1. Click the Leftmost drop down in the Attribute toolbar.

A list of available dictionaries appears on the drop down list. 2. Highlight the desired dictionary by scrolling up and down the list.

To select the dictionary, release the mouse when the dictionary is highlighted.

For more detailed information about Dictionary, see Attributes.
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Selecting the Current Group or Package
An attribute package is a collection of attributes that are manipulated in Digital Project as a unit. A group is a special feature created in the specification tree. Although there are many groups and attribute packages, during run-time only the current group or attribute package is active. Many Digital Project features function in the context of the current group or attribute package: • • • • attaching attribute package to a geometry creating a group filtering geometries using attributes removing attribute package from geometries

To work with groups or attribute packages within Digital Project, you must switch between different dictionaries and different groups or attribute packages within these dictionaries and then activate the desired group or attribute package as the current group or package. This task shows you how to select a group or attribute package as the current group or package. 1. Click the Rightmost drop down on the Attribute toolbar.

A list of available groups and packages in the current dictionary appears on the drop down list. 2. Highlight the desired group or package by scrolling up and down the list.

When you release the mouse after highlighting a selection, you select that group or package as the current package. For more detailed information about selecting dictionary, see Selecting the Current Dictionary. For more information about attributes see attributes.

Working with Packages
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Working with Packages
An attribute package is a collection of attributes that are all applied and managed together. Attaching attribute packages transforms geometry into intelligent architectural components. As a good policy, we recommend architectural components to be modeled as bodies or geometrical sets. This means attribute packages should be attached at this level of the tree. The only exceptions to this would be MEP and structure components.

Assigning Attribute Packages to Geometry
This task shows you how to attach an attribute package to geometry.

1. Set the dictionary containing the attribute package you wish to attach as the current diction Select Current Dictionary for detail.

2. Set the attribute package you wish to attach as the current package. See Select Current Att Packages for detail.

3. Select the geometry you wish to add the package to. You can use any standard method of s including multi-select, search, or selection sets. You should use the Feature Filter in the U Selection Filter to ensure that you are selecting objects accurately.
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4. Click the Attach Package

icon on the Project Attributes Toolbar.

A dialog box similar to the following will appear:
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In the example above, the package being attached is Masonry Assemblies and this package includes attributes: Division, CSI Number and Spec Number. 5. Enter the desired value for each attribute that is not read-only. 6. Complete the attachment process by clicking the OK button.

For more detailed information about assigning Microsoft Project Attribute, see Linking Geometry to Project.

Copying Attribute Packages
Paint Packages command copies the attribute packages from any single object to another. It copies all packages carried by the selected object that are sub-types of the chosen package type.. It is available for both product and part workbenches.

This task shows you how to copy attribute packages from one object to another.

1. Select a dictionary, of which, you wish to copy the attribute packages, as the current dictionary.

2. Select the attribute package you wish to copy, as the current package.

2. Alternative: If you want to copy all packages of the object, independent of their type, choose the following option.

11

attributes

3. Click Paint Packages

on the Project Attributes Toolbar.

4. Select an object from which you wish to copy the current attribute package.

5. Select an object to which you wish to copy the current attribute package. The Paint Attributes confirmation dialog appears...
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6. Click OK on the dialog to complete copying of attribute packages.

Removing Attribute Packages
This task shows you how to remove an attached attribute package from a geometry. 1. Select the dictionary containing the package you wish to remove as the current dictionary. See Select Current Dictionary for detail. 2. Select the attribute package you wish to remove as the current package. See
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4. Select the Geometry from which you wish to remove the current attribute package. The Remove Package confirmation dialog appears...

Click OK on the dialog to complete the removal of the current package. Note: • • Not only the current package, any package that is a sub package of the current package will be removed. To remove all the packages from the geometry: in Step 1, select Base as the current dictionary and in step 2, select All Packages as the current package.

•

To remove packages from multiple geometries, you can do a multiple selection before clicking Remove Package button.

For more information about Attributes, see Attributes.

Working with Groups
Working with Groups
14
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Groups are features that provide an intelligent collection of objects as a single node in the specification tree.

A Dedicated CATProduct
Groups are generally used to model collaboration information such as issues. They do not belong to the master model and should be exchanged without the need to reissue it. We recommend the use of dedicated CATProducts to model your groups, which reference the master model. This can ease collaboration and sharing between architects, contractors, etc: Assuming each party will have their local copies of the master model, you can simply exchange the Group CATProduct versus much larger files. In addition, you can avoid modifications to the master model with this method. Dedicated Design Issues CATProduct with Master Model Inserted

Attributes of a Group
When adding features to a group, the attributes of the group then apply to all those features. This can be advantageous in some instances. If you wanted to apply an attribute with the same value to multiple pieces of geometry and wanted that value to be maintained across those pieces, doing this with attribute packages could possibly lead to a discrepancy: you would have to remember each piece of geometry you had intended to have that value and update the value. Groups can help record your intent with its list of features.

Content of a Group

15

attributes Groups are based on links to reference geometry, similar to Ref-Ref links in V5. There are some impacts because of this. For example, take the model below with many instances of the same building sub-system FLOOR_ASSEMBLY.
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This is NOT recommended. Because groups keep links to references of existing objects, the instance information of those objects is not maintained. If a part has multiple instances in a document groups are created in, unintentional or unexpected results could occur when adding a part or objects within that part. The image to the left illustrates: The body Walls that is highlighted was added to the group Design Issue.1. It does not matter what instance you had chosen Walls in, the link to the reference is kept.

What is recommended if you have a master model with multi-instantiated subsystems with objects you want to add to a group, is to create a dedicated CATProduct for one of the sub-systems such as the image below.
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Creating a Group
A group is a feature in the specification tree that has a collection of references to other objects. This task demonstrates how to create a group. 1. Create a new product to contain your group.

2. Insert an existing design model.

The model has a body with a wall that is missing a cutout and an annotated view that points to the problem.
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3. In the Project Attributes toolbar, choose the appropriate dictionary and group from the dropdown.

4. Click Group

in the Project Attributes toolbar. The dialog box appears.
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5. A default name for the group is provided. This can be changed at any time to something more descriptive.

6. The group attributes can be set if there are any available.

7. Select items in the tree to place them in a group. For this example, let's select the wall that is missing the cutout and the annotation.
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8. Click OK to commit the group creation.

Below we see the result. The group root Design Issues is created for the given type of group. Beneath the root is the new group Design Issue.1. The group contains references to the two important pieces of information in the model pertaining to the missing cutout.

Editing and Reviewing a Group
Once a group has been created, you can easily review and edit it. This task shows you how to do so. 1. Open the product containing your groups and design model(s).
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2. Right-click on a group and go to the object definition and select that menu option.

The Edit Group dialog box appears.
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3. Edit the description and click OK.

4. Look at the group definition again to review. This time double-click on the group. The Edit Group dialog box appears.

23

attributes

5. Select the body CMU_LEVEL1.1 in the list of objects in the group and click Reframe On. Digital Project reframes on the body.
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6. Double-click on the annotation ViewMissingCutout in the list of objects in the group. The definition of the annotation appears.
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Double-clicking some objects in the list of a group to see the object's definition may cause the group dialog box to close, since you are essentially issuing another command. Because of this, be sure to save any changes (clicking OK) to the group name, attributes, list of features, etc., before double-clicking objects in the group's feature list. 7. Click OK to close the dialog.

Adding Objects to a Group Using a Query
Besides manually selecting objects to add them to a group, you can also use the query functionality to scan the specification tree for objects meeting specified requirements. This task will show you how to add objects to a group using the query. Familiarity with group creation (Creating a Group). 1. Open the product containing your groups and design model(s).
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2. Double-click on the group DI Coating Needed to edit its definition. The Edit Group dialog box appears.
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3. Click Query. The Attributes Query dialog box appears.

4. Let's say we decide all the important bodies in our model should be added to this group because they need a coating. Check Sets and Bodies in the Geometry frame.
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5. In the Attributes frame, the list on the left contains the available dictionaries. We know these important bodies have a MasterFormat package attached, so select the MasterFormat dictionary. 6. The list on the right fills with packages corresponding to the dictionaries selected in the previous step. Select the MasterFormat attribute package. This will find all the bodies and geometrical sets that are attributed with MasterFormat packages.

If you would like to query for objects, at least one type of geometry has to be specified. You can query objects for any number of packages or groups across dictionaries, but it is not necessary to select any in the list. 7. Click OK in the query dialog box. The objects the query found that are not already in the feature list of the groups dialog are added.
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The query functionality can also be used during group creation.

Organizing Groups
By default, the first group of a specific type is created under a corresponding group root. The group roots are children of the root product.

30

Basic Tasks

The current methods to achieve an organization other than the default are activation, cut and paste, and drag and drop, all of which are outlined below.

Activation
If subgroups under a specific group are desired, a group may be activated. When a group is activated, all newly created groups become its subgroups until it is deactivated. To activate a group, right-click on it and select Activate/Deactivate Group in the contextual menu.

The group becomes underlined to reflect it has been activated.
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Now subgroups may be created.

Cut and Paste
Cut and Paste is especially useful if it is accidentally forgotten to activate a group to make subgroups. These commands are available in the contextual menu of a group.
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However, the Cut functionality is disabled for a given group if it has subgroups
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Drag and Drop
A drag and drop is the act of left-clicking on an object, and while holding the mouse button down, dragging the object to the desired location and releasing the mouse button. Dragging and dropping a group acts as Cut and Paste does. Therefore, the same rule applies that if a group has subgroups, it cannot be dragged and dropped.

Content Looping
Groups are safeguarded from adding objects that will create loops in the tree. This means some objects cannot be added to a given group. For example, in the image below the groups DI Parapet Height and DI Window Distance cannot add the root product SD Issues. Also, because DI Window Distance (orange) is grouped by Change.1 (red), the DI Window Distance is prevented from grouping Change.1 (red).
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Working with Attributes
Working with Attributes

Attributes are a concept shared among groups and packages. Because of this, commands dealing strictly with attributes work the same way for: • • • packages groups objects within a group and therefore inherit the attributes of a group

Turning Dim Mode On/Off
Dim mode is one of the most effective tool in filtering geometries while working with attribute packages. It separates geometries into two groups rendered in different color, depending on whether the current attribute package is attached to the geometry:

Type Attached

Color model color

Not attached dimmed (grey) This task shows you how to turn dim mode on and off.
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The Dim Mode On/Off button has two states: on

and off •

.

To turn dim mode on, click the Dim Mode On/Off

button on the Attribute Toolbar. • To turn dim mode off, click the Dim Mode On/Off

button on the Attribute Toolbar.

The dim mode operates when: • • • attaching attribute packages removing attribute packages editing attribute packages

For example, when dim mode is on, and you click "remove package", the geometries that have the current package attached will be in their model color while the other geometries will be in greyed out.

For more detailed information about Attribute Toolbar, see Attribute Toolbar Description.

Modifying Attributes
The purpose of this task is to explain how to modify the attributes attached to a particular piece of geometry. The attributes can come from two sources: the attribute packages attached to the geometry or the group that the geometry belongs to. • • Modify attributes from attribute packages Modify attributes from group
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Prerequisites. Understanding of what attributes are; Ability to select attribute dictionaries and packages; Familiarity with the Geometry workbench; Facility with selection and toolbars. Modify Attributes from Attribute Packages 1. Select the attribute package that contains the attributes you wish to modify (in the image below, B2010 Exterior Walls).
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2. Select the geometry that has this attribute package. To be precise with selecting attributed geometry, use the Feature element filter in the User Selection Filter toolbar:

3. In the Project Attributes toolbar

click Edit Attributes button

.

A window will appear allowing you to modify the selected attribute package.

4. In the attribute package dialog, you may edit any attributes that are not readonly. After you have edited these attributes, click OK to save the modified attributes and complete the task.

Modify Attributes from Group If a geometry belongs to a group, the attributes of the group are passed to the geometry. When editing the attributes of a group, please note that the changes affects all the geometries of the group. In this example, the Request for Interpretation.1 group contains BrickCladding (BrickCladding.1).
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1. Select ConstructionAdministration in the Dictionary combo box and select Request for Interpretation in the Package combo box.

2. Click the Edit Attributes button . Move the mouse over the geometry and notice the geometry that is aggregated by the current group is highlited.
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Basic Tasks 3. Click the mouse to select the geometry and the Edit Attributes dialog will pop up:

4. Edit any attribute and click OK to finish.
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Modifying Attributes by Editing Properties
This task will demonstrate how to view and modify all of the attributes of a particular geometry at

Prerequisites. Familiarity with attributes; ability to add attributes; ability to work with toolbars.

1. First, be sure that you are selecting geometry with the Feature Element Filter. This filter ensu features are selectable; this is crucial since attributes are always attached to features (for example sub-geometry of these features (for example, one face of a solid). If Feature Element Filter is not a select geometry, not all of the attributes assigned to that geometry will be visible to you.
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Before activating the Feature Element Filter, you must be working in the Geometry workbench (Start > Project Center > Geometry). Once you are in the Geometry workbench, activate the Feature Element Filter by adding the User Selection Filter toolbar and clicking Feature Element Filter . When activated, the filter will toggle orange . If the user selection filter is not visible, you can show it by right clicking on any toolbar and clicking Feature Element Filter in the contextual menu.
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2. Right-click on the geometry you wish to modify. Select Properties from the contextual menu to dialog.
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3. In the properties dialog, click the "More" button. A tab will appear labeled "Project Attributes". W appear a tab for each attribute package that the geometry has.

4. In each tab, all of the attributes of the selected package appear. if they are not read-only, you m attributes directly in the dialog. After you have finished modifying the attributes, click exit the properties window, and complete the task. to

Filtering Geometry Using Attributes
One of the simplest and most powerful ways to use attributes is to create visualizations that clearly show how the building components with a certain type of attribute are distributed within a building assembly. These visualizations are created using attribute filters. This task explains how to use Digital Project's filters to color the model geometry based on attributes.
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Prerequisites. • • • • Understanding of attributes Ability to Add, Remove, and Edit attributes Familiarity with Toolbars Facility with the Geometry and Project workbenches

1. Open a Digital Project model using File -> Open To use attribute color filters, your active model must have some attributes added to its geometry. If your model does not have any attributes, refer to Assigning Attributes Packages to Geometry.
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Basic Tasks 2. After assigning attributes to model geometry, select the attribute package that you want to filter on from the package Project Attributes toolbar by selecting from the second drop down list. In this example, we select the Uniformat dictionary and the Uniformat package.

Since attribute packages are arranged hierarchically, attribute filters take advantage of this hierarchy. If you filter based on an attribute package, you automatically filter on all of its children. The hierarchical arrangement of attribute packages is particularly useful when filtering on architectural element classifications such as Uniformat or Masterformat. By selecting the Uniformat package, for example, you can filter on all Uniformatderived packages (such as A1010 Standard Foundations, or C1020 Partitions) at once.

3. Once you have selected an active attribute package, click on Color Geometry based on Attribute Values in the Project Attributes toolbar

A dialog box similar to the following will appear.

Follow the links A, B, C, D, E, F, and G to see its corresponding description
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Follow the links A, B, C, D, E, F, and G to see the description To skip the table below, follow this link. Purpose: Select the color of geometry that does not have the A current package or any package derived from the current package Select the color of geometry that has the current package B or any package derived form the current package One tab appears for each attribute associated with the package. You may filter C based on a different attribute by switching tabs. If the current package has sub packages, the Sub Options: Check the Hide check box to hide all geometry that does not have the current package Check the Hide check box to hide everything with the current package, or check the Select check box to select everything with the current package
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Package tab will appear so you can color the geometry based on if it has a certain subpackage. You may filter an attribute either by one of the following • D • Single Value (e.g. select everything that has has Review Status value Approved) Range (e.g. select everything that has Room Capacity value from 10 to value 20)

Select the color for any geometry that has the attribute with the specified value or that falls within the Check the Hide check box to hide the geometry. E specified range. If there are Check the Select check box to select the geometry. discrete values for a particular attribute, these discrete values will appear in a drop-down menu. Clear: clear the current filter (revert to default settings for the filter dialog) Apply: apply the filter to the current model. F Export: export the filter settings to XML file Add to Tree: Add a color filter feature to the spec tree with the current filter settings as its content. Reset: reset the 3D model to its original colors or close the G dialog. Close: close the dialog Modify the dialog for the desired behavior:
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4. After you have changed the filter, click Apply.
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The model is now filtered appropriately.

5. If you want to revert to the original, default coloring of the model, open the color filter window and click Reset. Or you can click the Dim/Undim button in the Project Attribute toolbar to reset.

51

attributes

Working with Interactive Excel Data Sheets
Working with Interactive Excel Data Sheets

Excel data sheets are specialized groups that offer detailed reports in Microsoft Excel. With Excel data sheets, Digital Project and Microsoft Excel are able to exchange information on object identifiers, attributes and Knowledgeware parameters. Excel data sheets can create reports ad hoc or from special templates. In the images below, we can see Excel Data Sheet.1 is managed the same way as a normal group in the tree with its referenced features. Each object in the data sheet has its own report row, as can be seen in Excel Data Sheet.1's corresponding Microsoft Excel file.
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Setting Up the Environment for Excel Data Sheets
GTCExcelDataSheetFilePath is an important Excel data sheet "CATEnv" environment variable in Digital Project. Set this variable to a special directory where you would like to create and keep your Excel data sheets. By default, GTCExcelDataSheetFilePath is set to the same directory as the default CATSettings directory location: C:\Documents and Settings\User\Application Data\Gehry Technologies\Datasheets

Creating an Excel Data Sheet
Excel data sheets are specialized groups that are able to interact with Microsoft Excel. This task shows how to create a useful Excel data sheet. A proper environment for creating data sheets is required for this task (Setting Up the Environment for Excel Data Sheets). Also, familiarity with groups is recommended (Working with Groups). 1. Create a new product to contain your Excel data sheet.

2. Insert an existing design model.
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3. Select items in the tree you would like to place in the Excel data sheet. For this example, we will select all the bodies with geometry. in the Excel Data Sheets toolbar. The Add Excel 4. Select Excel Data Sheet Data Sheet dialog box appears with all the features pre-selected in the model.

While groups are traditionally created based on the current dictionary and current group in the Project Attributes toolbar dropdowns, Excel data sheets may be created regardless of those dropdowns. 5. There are two names related to a data sheet. In the dialog box, Name will be the name of the Excel data sheet feature that will appear in the Digital Project specification tree. Data sheet name will be the name of the Excel file. You can change these names to something more descriptive. 6. The Report Data frame contains reporting options. Please see Reporting Options for Excel Data Sheets for more details on what the options in this frame mean for your reports. Let's choose Feature Name and Volume.

7. Click Apply. An Excel file is generated and populated with the reporting options by column and the objects selected by row.
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The grey cells seen in the Microsoft Excel file above are Digital Project's way of indicating those cells are read-only. 8. In the Excel file, let's change the names of the last two bodies by adding an underscore before the level numbers.

When you are done editing in Microsoft Excel, be sure to Tab out of the cell you were last working in or hit the Enter key. This will take you out of Edit or Enter mode and get you back to Ready mode in Excel. You must be in Ready mode in the Excel file before updating the Digital Project model. Otherwise, Digital Project will appear to "hang" while it is waiting for Microsoft Excel to finish any edit. You can check to see what mode you are in by looking at prompt in the lower left corner of Excel:

9. In Digital Project, click Update 3D in the dialog box.
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The model updates with the changes we have made in the Excel.

When using Update Excel or Update 3D, the Cancel button of the Excel Data Sheet dialog does not undo any results of these actions. 10. Click OK.

Below we see the result. The group root Excel Data Sheets is created. Beneath the root is the new Excel data sheet Excel Data Sheet.1. The data sheet contains references to the bodies we selected.
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For explanations of the Report Data frame options, see Reporting Options for Excel Data Sheets.

Creating an Excel Data Sheet from a Template
The reporting columns in an Excel data sheet may be specified through a template. This task demonstrates how to create an Excel data sheet from a template. An existing template IssuesTemplate.xls used in this example will report a feature's name, its Design Issue sub-type, and its Design Issue description.
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An existing template and a proper environment for creating data sheets is required for this task. Also, familiarity with creating data sheets and groups is recommended. 1. Open the product containing your groups and design model(s).

2. Select items in the tree you would like to place in a group. For this example, we will select all the bodies with geometry. in the Excel Data Sheets toolbar. The Add Excel 3. Select Excel Data Sheet Data Sheet dialog box appears.
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4. In the Report Data frame, there is a section to specify a template. Enter the full path of a template here or choose one with the file chooser.

When you specify a template, the selectable reporting options are cleared and disabled. If you decide to not use a template, delete the template path you specified and press the Tab key to get out of the editor. The reporting options will become enabled again. 5. Click OK to create the data sheet.
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For information on creating your own templates, please see Creating Excel Data Sheet Templates. For explanations of the Report Data frame options, see Reporting Options for Excel Data Sheets.

Reporting Attributes with an Excel Data Sheet
Excel data sheets are a powerful way to generate reports for attribute rich models. This task demonstrates how to report those attributes with Excel data sheets. 60

Basic Tasks A proper environment for creating data sheets is required for this task (Setting Up the Environment for Excel Data Sheets). Also, familiarity with creating data sheets is recommended (Creating an Excel Data Sheet). 1. Open the product containing your groups and design model(s).

2. Select items in the tree you would like to place in a group and report attributes on. For this example, we will select all the bodies with geometry. in the Excel Data Sheets toolbar. The Add Excel 3. Select Excel Data Sheet Data Sheet dialog box appears with all the features pre-selected in the model.

61

attributes

4. Click Report in the Attributes sub-frame of Report Data. The Attributes Selection dialog box appears with a list of available dictionaries in the leftmost selection list.

5. Select one or more dictionaries to view a list of corresponding packages.

6. Select one or more groups or packages in the middle selection list.
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7. Select the attributes you want reported in the Excel data sheet in the rightmost selection list. For each package, an additional option of "<SubType>" is presented to allow a report on the group or attribute package subtype.

8. Click OK in the Attributes Selection dialog box. The attributes selected in the Attributes Selection dialog box are listed in the Report Data frame for reference and convenience.

9. Click OK.

Below we see the result. The group root Excel Data Sheets is created. Beneath the
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Here we see the related Excel file with the attribute information available for each feature that was selected.

For explanations of the Report Data frame options, see Reporting Options for Excel Data Sheets.
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Interacting with an Excel Data Sheet
This task illustrates the two-way integration between an Excel data sheet and its corresponding Microsoft Excel document. Familiarity with attributing models and reporting attributes with Excel data sheets. For information about reporting attributes with Excel data sheets, see Reporting Attributes with an Excel Data Sheet and Reporting Options for Excel Data Sheets. 1. Open the SD Issues CATProduct where we created the Excel data sheet in the previous task Reporting Attributes with an Excel Data Sheet.

Excel Data Sheet.1's Excel file below:
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2. Change the name of the last two bodies by adding an underscore before the level numbers.

3. Double-click on the Excel data sheet. The definition dialog box appears and the Excel file comes to the front of the computer screen.

There are a few things to note here. First, the Report Data frame is no longer available. Second, the dialog box reflects the new name of the last two bodies, but the Excel file does not.
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4. Click Update Excel.

When using Update Excel or Update 3D, the Cancel button of the Excel Data Sheet dialog does not undo any results of these actions. 5. In the dialog's list of objects, select the two bodies whose names were changed and click Show In Excel.
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The features are highlighted in the Excel document and we can see the updated names in the Excel file.

6. In Excel, we are going to edit an attribute value for the body PARAPET, but let's double check it is the body we had in mind. Select the feature in Excel.
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7. In the Digital Project dialog, click Show In 3D. The feature is highlighted in the dialog and the 3D model.

8. Back in Excel, edit the attribute values for the 04200 Masonry Unit Spec Number. Also, edit the description for the Design Issue the body PARAPET is a part of.

When you are done editing in Microsoft Excel, be sure to Tab out of the cell you were last working in or hit the Enter key. This will take you out of Edit or Enter mode and get you back to Ready mode in Excel. You must be in Ready mode in the Excel file before updating the 3D model, or Digital Project will appear to "hang" while it is waiting for Microsoft Excel to finish any edit. You can check to see what mode you
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9. In Digital Project, click Update 3D. The new attribute values are updated in the model.

10. Click OK in the Edit Excel Data Sheet dialog box to exit out of the command. We can see the updated values.
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Reporting Options for Excel Data Sheets

Excel data sheets create group features in the tree and generate Microsoft Excel documents based on user-specified reporting options. This document describes these reporting options in further detail.

Before Reading this Guide
Before reading this section on Reporting Options for Excel Data Sheets, you should be familiar with the following topics in Digital Project: • • Creating an Excel Data Sheet Reporting Attributes with an Excel Data Sheet

71

attributes

Report Data
The Report Data frame in the Add Excel Data Sheet dialog box dictates the information reported in the Microsoft Excel file. The frame is only available during Excel data sheet creation. There are two ways to precise the report information : one is to specify a template and the other is through manual selection. Each option selected generates a corresponding column in the Excel document. The following topics in this document delve farther : Reporting Non-Attribute Information, Reporting Attribute Information, and Templates.

Reporting Non-Attribute Information
Non-attribute information includes identifiers and calculations.

Identifiers

The Identifiers options provides available information on object names, their types, and their ancestors. Currently, the Instance Name option will generate two reporting
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Calculations

The data sheet will gather calculations for the corresponding quantities of compatible objects. The units for each magnitude of the results are defined in: Tools->Options->Parameters and Measure->Units

Reporting Attribute Information

The Attributes frame assists in reporting attributes and sub-types of groups and attribute packages. The two important parts of this frame are the Report button that launches an Attribute Selection dialog box and the Inherit from Ancestor checkbox.

The Attributes Selection Dialog
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When clicking on the Report button in the Attributes frame, the Attributes Selection dialog box opens. The leftmost list consists of available dictionaries. By selecting one or more dictionaries, the middle list is filled with all the corresponding groups and/or packages. For each group or package selected in the middle list, the rightmost list of attributes from those groups and packages and an additional option of "<SubType>" for each group and package is presented. Each attribute selected in the attributes list will have its own column in the Excel data sheet. The selected attributes in the Attributes Selection dialog box are listed in the Report Data frame for reference and convenience.

Inherit from Ancestor
Attribute Packages

Inherit from Ancestor is a special option: it allows a feature to report attributes from another feature that is higher in the tree up to a product level. For instance, take this simple pad.
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Groups

Inherit from Ancestor also applies towards groups. In the image below, PartBody is grouped by Grouping.1. As seen previously, the attributes of a group can be reported by a feature in that group. With the Inherit from Ancestor option, a feature such as Pad.1 can temporarily inherit the grouping of PartBody and report the attributes of Grouping.1.

Say we want to report the Description attribute of the group Grouping.1, which contains PartBody. The result of Inherit from Ancestor unchecked on the left and checked on the right.
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Templates

Templates can encompass all the above reporting options. A user can also report Knowledgeware parameters with templates (see Creating Excel Data Sheet Templates). The template file chooser defaults to the directory specified by CATStartupPath + "\templates", but templates can be located anywhere on a machine or network. When a template is specified, the other non-template reporting options are cleared and disabled:
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Generating an Interactive Door Schedule
This task explains how to generate an interactive door schedule from a model with inserted doors. 1. Begin by opening the Product model that you wish to create a door schedule from with File->Open. This Product model may already have doors inserted, or you may wish to insert additional doors. 2. Select Interactive Door Schedule . After clicking the Interactive Door Schedule icon, the Run Door Schedule dialog is in the Excel Datasheet toolbar

launched. The Door Schedule searches the product document for all Door UDFs (each of which has a door attribute package attached) and reports information from them. There are two types of door schedule: • AIADoorSchedule - the standard Uniform Drawing system door schedule. • DetailDoorSchedule - reports all of the information in every door attribute package. Since the steps for creating the two reports are nearly identical, we will go through the steps creating a detailed Door Schedule. 3. Choose "DetailDoorSchedule" then click OK on the Run Door Schedule dialog. A Door Schedule Datasheet feature will be created and placed in the 3D Spec Object tree.
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4. Excel will launch and open a Door Schedule template. A unique file name will be generated for this new template and the template would be automatically save to a file in the directory specified by the "GTCExcelDataSheetFilePath" Digital Project environment variable. This template will then be filled with information from the 3D model.

5. To save the content just populated in the template, in Excel, save the door schedule: File->Save.

78

Basic Tasks Because a Door Schedule is also an Excel Datasheet, a user may interact with it like any Excel Datasheet. A user may change what is being reported by removing or adding columns in the Excel template. A user may also update and upload data interactively between Excel Datasheet and the 3D model by using the Datasheet edit feature.

Generating an Interactive Window Schedule
This task explains how to generate an interactive window schedule from a model with inserted windows. 1. Begin by opening the Product model that you wish to create a window schedule from with File->Open. This Product model may already have windows inserted, or you may wish to insert additional windows. 2. Select Interactive Window Schedule . After clicking the Interactive Window Schedule icon, the Run Window Schedule dialog in the Excel Datasheet toolbar

is launched. The Window Schedule searches the product document for all Window UDFs (each of which has a window attribute package attached) and reports information from them. There are two types of window schedule: • AIAWindowSchedule - the standard Uniform Drawing system window schedule. • DetailWindowSchedule - reports all of the information in every window attribute package. Since the steps for creating the two reports are nearly identical, we will go through the steps creating a detailed Window Schedule. 3. Choose "DetailWindowSchedule" then click OK on the Run Window Schedule dialog. A Window Schedule Datasheet feature will be created and placed in the 3D Spec Object tree.
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4. Excel will launch and open a Window Schedule template. A unique file name will be generated for this new template and the template would be automatically save to a file in the directory specified by the "GTCExcelDataSheetFilePath" Digital Project environment variable. This template will then be filled with information from the 3D model.
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5. To save the content just populated in the template, in Excel, save the window schedule: File->Save. Because a Window Schedule is also an Excel Datasheet, a user may interact with it like any Excel Datasheet. A user may change what is being reported by removing or adding columns in the Excel template. A user may also update and upload data interactively between Excel Datasheet and the 3D model by using the Datasheet edit feature.

Construction Coordination
Construction Administration
Digital Project has a set of construction coordination tools developed in Visual Basic (VB) using the group concept. The VB source code can be found in your Digital Project installation directory in the subfolder VBScript. The VB code is thoroughly documented and should be adapted to each project specific process. Templates for construction documents can be found under your project standards installation at: \startup\templates\ConstructionAdministration The construction coordination tools can be found in the Construction Administration toolbar:

This custom application allows to integrate Request for Interpretation (RFI), Supplemental Instructions (SI), and other construction coordination documentation with the master model in Digital Project. See the image below: an RFI Response group created in Digital Project and the RFI Response document linked to it.
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Importing an Issue Form
This task shows you how to import an issue form.

1. Consider a sample 3D model as follows, in which you would like to import an issue form.

2. Consider a sample issue form, data of which you would like to import.
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3. Construction Administration toolbar can be found by right clicking on any of the toolbars (gray areas on all four sides) of Digital Project and by selecting as shown in the figure.

Command in the Construction Administration toolbar. A 4. Click on the New Issue file open dialog box appears...

5. Select an issue form and click on the Open button.
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6. Click OK.

7. Issue gets added in the tree as shown in the figure.
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8. Double click on the added issue to see its attributes that were extracted from the input issue form.

Generating a Response
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1. Consider a sample 3D model as follows, to which you would like to add a response. Select an issue type as shown in the figure.

2. Click on the Create Response toolbar.

Command in the Construction Administration

3. Click OK.

4. Response gets added in the tree to the selected issue as shown in the figure.
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5. Double click on the added response.

6. Inform some attribute values to the response.
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7. Add building elements, DMU views, measures etc. to better describe the response.
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Generating a Response Document
This task shows you how to generate a response document of given issue type.

1. Consider a sample 3D model as follows, that has a response with attribute values as shown.
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2. Click on the Update Response Document

Command in the Construction Administration too

3. Click OK.
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4. A form is generated, filled with the attribute values of the response as shown in the figure.

Updating an Issue Document
This task shows you how to update an issue document.

1. Consider a sample 3D model as follows. Double click on the selected issue in the tree (as show values. Click the encircled button to view the issue document.
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2. The issue document opens up. As you can see there are few attributes (highlighted) that are no current attributes.
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3. Click on the Update Issue Document

Command in the Construction Administration toolbar.

4. Click OK.

5. Issue document is updated and as you can see, the attributes are now in synchronization with t
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Updating an Issue from Document Change
This task shows you how to update an issue from the modified issue document.

1. Consider a sample 3D model as follows, the issue of which you would like to update from any c document. Double click on the selected issue in the tree (as shown) to see its current attribute to view its issue document.
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2. The issue document opens up. Modify the highlighted attributes of the issue document as show
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3. Click on the Update 3D Issue

Command in the Construction Administration toolbar.

4. Click OK.

5. Issue is updated with the attribute values supplied by the modified issue document.
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Producing a Cost Estimate
This task explains how to create both a rough and a detailed Uniformat cost estimate from a model with correct attributes. Prerequisites. • • Ability to add, remove, and modify Attributes Ability to use Microsoft Excel

Digital Project provides quick, useful, and extensible cost estimation functions. These functions are associated with the attributes attached to a model. Digital Project's cost estimation formats and procedures conform to industry standards for element classification and cost accounting. The Uniformat cost estimation function adheres to the standards for cost summaries and element cost estimates outlined in the October 1999 edition of UNIFORMAT II. While this task shows how to create a Uniformat cost estimate, you could modify the VBScript application that generates the cost estimate to produce an estimate based on any other standard as well. 1. Since an accurate detailed cost estimate depends on classification information, the Digital Project model must have all the attributes associated with a particular classification system. In particular, to create a Uniformat cost estimate, all attributes for all geometry to be reported must be part of the Uniformat package. To generate an accurate Uniformat cost estimate, the 3D model must have attributes in packages that include an individual element number (e.g. A1020, D3010, C3020). Packages that supply only a Major Group (e.g. A,B,C,D,E) or Group Number (e.g. B10, D30) are insufficient.
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Care must be taken in thinking through the relationship between • • • How a particular type of building element is modeled. How this building element is reported. If the report must provide the surface area of this wall to generate the cost for a particular type of fascia, the finish surface of the wall should be modeled as a distinct surface. If the entire wall is a solid and the user extracts the area of the wall, the entire surface area of the solid will be reported, not simply the exterior surface area (yielding over double the expected area!). If the wall is cast-in-place concrete and the user wants the volume of poured concrete, the wall should be modeled as a solid. In practice, a faced concrete wall would be modeled as a solid with surfaces extracted on the side of the fascia to ensure accurate reporting of the surface area.

Consider a very typical example: an exterior wall.

•

• •
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2. Once the model has attributes assigned to all its elements, you may want to verify that every element of the model (or all of the elements for which costs should be estimated) has attributes. The simplest way to do this is with a color filter. Select Uniformat for both dictionary and package, and select the color filter from the Project Attributes toolbar:

In the color filter dialog, check the Hide Uniformat checkbox, and press Apply.

After applying the filter, only the window will only show the geometry without the Uniformat package.
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3. When all of the geometry to be reported has attributes assigned to it, activate the Uniformat Cost Estimation command by go to: Data->Uniformat Cost Estimation.
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4. After you have activated Uniformat Cost Estimation command, Microsoft Excel will open the cost estimation template. The system will insert into the spreadsheet measure or number takeoffs for all of the building elements that have attributes assigned to them, and the cost estimate will be tabulated.

This spreadsheet is simple an output; modifications made to the it will not affect the original model. Since modifications to the original model will not automatically be
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5. Digital Project does not save this cost estimate by default. To save the estimate, use the File -> Save dialog in Excel to complete the task.

Digital Project's cost estimation combines measure and number takeoffs from the 3D model with estimation rates and tabulation procedures from the Excel-format cost estimation template. No rate information appears in the model; it must be modified in the cost estimation template.

Working with Attributes
Integrating Knowledgeware Parameters with Attributes

This task explains how to use attributes like other Knowledgeware parameters.

Prerequisites. • • Familiarity with Knowledgeware parameters Understanding of basic attribute manipulation (adding, removing, editing)

Overview. While they have additional capabilities, project attributes can be used just like any other Knowledgeware parameter. They may be used in formulas, with rules, and as attribute links in annotations. The following task gives an example of how project attributes appear in Knowledgeware. The scenario is setting up a cost for a floor, given a certain cost per area.
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1. Open a model with File -> Open.

2. Add an area attribute to a floor of the model.

3. Select the root product and hit the formula

button.
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4. In the Formula dialog, click parameter 'Total Cost', click Apply, and click OK.

, with type real. Name this

The parameter will appear in the specification tree under Parameters.

5. Double-click on the 'Total Cost' Parameter, right click on the numeric value, and select Edit formula.
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Select Area under Members of Parameters. A member of area appears with 'CATSpecXMan.1' in the name. This identifies this parameter as an attribute. Double-click on this member to add it to the formula, and multiply this by 200, our cost per square meter.

Click OK to exit the formula editor.

7. 'Total Cost' now has the appropriate cost, derived from attributes and multiplied by the proper factor.

Attributes can be used in any Knowledgeware-enabled application within digital project, not only formulas.
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Using HyperLinks
This task explains how to use hyperlinks. See also: Defining attributes as hyperlinks.

Prerequisites. • Understanding of basic attribute manipulation (adding, removing, editing)

Overview. A hyperlink attribute provides the ability to open a document associated to the attribute. The document can be a web page, Microsoft Word, Microsoft Excel or PDF file. If the bookmark is specified in the hyperlink attribute, the document can be opened and positioned to the bookmark. The document can reside on the local computer, on the local network or on the Internet. 1. In Project Attributes toolbar, select DesignCollaboration dictionary and the Design Issue group.

2. Click the Group

button.
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Advanced Tasks 3. In the Add Group dialog, check the Link radio button and enter file:///C:\Projects\Arena\DesignIssues\Issue271.doc in the text field for the Attachment attribute.

Hyper Link Syntax: • • Name: Any name of the hyper link, such as Design Issue no. 271. Link: The link to a document on a local file system starts with file:///C:\Project\Arena\DesignIssues\issue271.doc, or the link to web document such as: http://www.arena.com/issues/issue271.html . Source: It is the same as the standard HTML hyper link syntax: <a href="url">name</a> The <a> tag is used to create an anchor to link from, the href attribute is used to address the document to link to, and the words between the open and close of the anchor tag will be displayed as a hyperlink name. For

•
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4. Click the

button to activate the hyper link and open the document.

Creating links to paragraphs of a document
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This task explains how to link an attribute to a paragraph of a document. Prerequisites. • Understanding of basic attribute manipulation (adding, removing, editing)

Overview. A hyperlink attribute provides the ability to open a document associated to the attribute. If the bookmark is specified in the hyperlink attribute, the document can be opened and positioned at the bookmark. To open the right document, the base of the link for the attribute must be specified in the dictionary, see Defining attributes as links to paragraphs of a document, for details. 1.Go to the edit dialog for the group you wish to create the link by double clicking its icon on the tree.
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Click on the button to open the document linked to by the attribute Attachment. The document will be opened and positioned at the first page. 2. Go to the paragraph you wish to link say, B1010 Floor Construction in the table of content of the document.

and highlight paragraph title.

3. Right click on the highlighted paragraph and select Toggle Field Codes on the popup menu.
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This toggle the paragraph title to the bookmark location:
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4. Enter the char "#", then copy and concatenate the hyperlink name "_Toc107651272" into the group edit dialog:
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The attribute Attachment is now linked to the paragraph B1010 Floor Construction. Clicking on the button paragraph B1010 Floor Construction. will open the document position at the

Instead of a paragraph, we have to specify the HTML page if the base is actually web site. In that case, we enter the page name we want the attribute to link to.

Working with Microsoft Project
Linking Geometry to Microsoft Project
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attributes As part of integration with Microsoft Project, Digital Project provides a set of basic attribute packages that contain attributes closely related valid task fields in Microsoft Project. These packages capture essential Project task information such as task name, task start date, and task end date. This information provides a framework for filtering geometries and simulating the construction process in 3D. This task shows you how to assign a Microsoft Project attribute packages to a geometry. For general information about assigning attribute packages to geometry see Assigning Attribute Packages to Geometry.

• • • •

Make sure that the current dictionary is MicrosoftProject. Make sure that the current package is a valid Microsoft Project Package -- it must be a child package of MS Project Task. Make sure that the application Microsoft Project is already installed on your system. Make sure that the project file corresponding to the current package exists. The full file path is specified by: ProjectFilePath\projectPackageName.mpp Where ProjectFilePath is the path specified by the GTCMSProjectFilePath environment variable and projectPackageName is the name of the current package.

1. Click Attach Package icon on the Attribute Toolbar:

2. Select the geometry to which you want to attach a Microsoft Project task. The following dialog appears:
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Digital Project will : • Launch the Microsoft Project application if it is not already running. Load the Microsoft Project file if it is not already loaded into MS Project. Switch Microsoft Project viewer to Gantt Chart view. Set Microsoft Project application as the active application with input focus.

•

• •

3. In Microsoft Project, select the Project task you want to attach to the selected geometry in Digital Project.

4. Switch to Digital Project and retrieve the selected Microsoft task data by 117

attributes clicking the Get Task button.

Digital Project will populate the above dialog box with task data retrieved from Microsoft Project.

If an attribute is not a valid task field or is not set in Microsoft Project, it would be set to <Unset>. In the above example, the attribute Visualize As is not a task field and its default value is set to <Unset> 5. For each attribute that is not a valid Microsoft Project task field, enter the desired value. 6. Finally, to complete the linking of the geometry and the Microsoft Project task, click the OK button to accept the changes and to save the data.
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Simulating A Construction Schedule in 3D Over Time
To integrate Digital Project with Construction Project management systems, Digital Project provides support for Microsoft Project, enabling you to simulate a construction schedule, viewing the effect on the 3D model. • • A Microsoft Project Project Schedule consists of a set of tasks. A Task is described by its Name, Start date, End date, and other information.

There are several items you can define within Microsoft Project. Some are associated with the entire project: • Project Start date - the earliest date any task starts. This date is used to determine the beginning of the simulation. The beginning date of the simulation is one day before this date. Project Finish date - the latest date any task finishes. Simulation ends one date after this date. Task Name. Task Start date. Task Finish date. Task UniqueID.

•

Others are associated with the task: • • • •

Digital Project supplies a standard Microsoft Project attribute package as a base package for Microsoft Project integration. Within this base package, Digital Project captures Microsoft Project task data By attaching an extended attribute package of standard Microsoft Project attribute to a particular geometry (e.g. ground floor concrete slab), you can associate a Microsoft Project task with that geometry. This enables you to associate a task with a geometry, attributing to the geometry the construction start date and end date as specified by the task's Start and End date. When you do this type of attribute attachment to a particular geometry, you can show that geometric object during simulation (at the simulation time) in one of the three states with its own visualization parameter. This state is determined by the construction start and end date and the current simulation time. o o o Not Start -- the tasks' Start Project Attribute is before the Microsoft Project Start date. In Progress -- when the simulation date is between the geometry's Project Attribute's Start and Finish date. Done -- when the simulation date is after the geometry's Project
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This task shows you how to simulate a construction schedule in 3D over time. Before you begin: • • • • • Make sure that Microsoft Project is the current dictionary. Make sure that the current package is a valid Microsoft Project Package -- it must be a child package of MS Project Task. Make sure that the application Microsoft Project is already installed on your system. Make sure that the project file corresponding to the current package exists. Make sure that there are Microsoft Project Attribute packages attached to some geometry.

1. Click the Microsoft Project Simulation icon toolbar

from the

Packages

Digital Project will: o Launch the Microsoft Project application if it is not currently running. o Load the Microsoft Project file if it is not already loaded into MS Project. o Switch Microsoft Project viewer to Gantt Chart. o Retrieve Microsoft Project data from the loaded Microsoft Project file. Retrieved data includes some Project specific data and a set of information from each task.
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o Load the Microsoft Project attribute packages corresponding to the Microsoft Project file. A Project Simulation dialog appears:

Note: Loaded Microsoft Project data project data and task data described above. See the definition of the three status states: Not Start, In Progress, and Done

2. On the Permanent tab, left click on the Not Start color-choose drop down menu and choose the Not Start simulation color by scrolling through the list.

You may also choose to hide the feature by checking the Hide check box. Similarly, choose the desired colors for In Progress and Done.
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• The white color is reserved for geometric model (transparent) color. 3. Repeat step 2 for the Temporary tab to set up simulation color for temporary construction features.

4. To begin construction simulation, press the

button.

5. To change the simulation date, drag the slider or pressing the up/down arrow on the Simulation Date

spinner. While the simulation date changes, the state of each geometry is computed and its color updated. 6. To restore the geometries to their model color, press the button.

7. To exit the Project Simulation command, press the

button.

For more detailed information about Microsoft Project and Attribute, see Linking Geometry to Microsoft Project.

Filtering Geometry using Microsoft Project Attributes
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This task shows you how to filter 3D geometry using Microsoft Project Attributes.

1. Make sure that MicrosoftProject is the current dictionary . 2. Make sure that the current package is a valid Microsoft Project Package -- it must be a child MS Project Task. 3. Make sure that the application Microsoft Project is already installed on your system. 4. Make sure that the project file corresponding to the current package exists.

1. Click the Color Geometry Based on Attribute icon

on the

Attribute Toolbar

2. This activates the color filter command. Digital Project will: • • • • Launch the Microsoft Project application if it is not already running. Load the Microsoft Project file if it is not already loaded into MS Project. Retrieve all task information from Microsoft Project Update all Microsoft Project package attributes with the newly acquired information.

The color filter dialog appears...
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2. Choose the color for geometries that do not have the current package attached to then from drop down list. If you wish to hide them, check the Hide check box.
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In this example, the current package is "MS Project Task".

3. Choose the color for geometries with the current package attached using the color drop dow the Hide check box to hide them. In addition, if you wish include these geometries in the s check the Select check box.
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4. Select the current attribute. Geometries will be colored according to the value of the curren 5. Select either Single Value or Range.
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Select Single Value if you are target specific attributes, otherwise select a Range of values. 6. On each row: • • • • Enter the attribute value (or a range of values)that you want to color. Select the color you wish to use for the value or range you entered. Check the Hide check box if you wish to hide the geometries having the Single Value or Range of values you specified. Check the Select check box if you wish to add the geometries to the selection set.

Note: There are a total of twenty rows for non-discrete value attributes while there is one row fo discrete value. 7. Activate the color filter by pressing the button. button. button.

• To reset the content of the color filter dialog, press the • To restore geometries back to model color, press the For more detailed information about 2D markers, see Annotating...
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Extending the Microsoft Project Integration Schema

This task explains how to extend the Microsoft Project integration schema.

Prerequisites. • • • • Familiarity with XML Facility with Microsoft Project Understanding of basic attribute manipulation (adding, removing, editing) Ability to create custom attribute dictionaries

Overview. Digital Project provides links to Microsoft Project with special Microsoft Project attributes. You can extend the basic functionality of these attributes by creating new dictionaries that take advantage of additional Microsoft Project task fields. This task shows you the XML syntax required to create a Microsoft Project dictionary. 1. Create a new XML file. Each package in this file should derive from GTCMppTask, which indicates that Digital Project uses these attribute packages to coordinate with Microsoft Project. For example, consider the following dictionary definition. <?xml version="1.0"?> <dictionary> <package> <pkgtype>ProjectMasterTimeline</pkgtype> <pkgsupertype>GTCMppTask</pkgsupertype> <pkgdisplayname>ProjectMasterTimeline</pkgdisplayname> <attribute> <attname>Baseline Start</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Baseline Finish</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Deadline</attname> <atttype>String</atttype> <attreadonly>true</attreadonly>
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Advanced Tasks </attribute> <attribute> <attname>Actual Cost</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Actual Duration</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Critical</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> </package> </dictionary>

Note that the following are Microsoft Project task fields • • • • • • Baseline Start Baseline Finish Deadline Actual Cost Actual Duration Critical

When this dictionary is compiled, Digital Project uses these Microsoft Project fields and will populate them from the MPP file name specified in <pkgtype>. In this example, all of the information populating these attributes will come from ProjectMasterTimeline.MPP.

2. After you have created your XML file, compile it to a .catfct file and put it in the appropriate directory. For more information, see Creating Custom Attribute Dictionaries.

3. The compiled dictionary will give you access to your extended Microsoft Project schema.

For a complete list of Microsoft task fields see Microsoft Project Task fields.
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Working with Primavera
Working with Primavera
Primavera integration in Digital Project provides capability to link 3D BIM (Building Information Model) objects to Primavera Project and Activities so to simulate the activities in 3D with respect to time. These capabilities help construction plan designer to determine correctness and efficiency of construction plan, and also to demonstrate the plan.

To work with Primavera in Digital Project you • need your IT Administrator for Primavera to o create an account in Primavera and provide you with login information (Login Name and Password) install Primavera Software Development Kit (SDK) on your workstation and provide you with the ODBC DSN (Data Source Name) that is mapped to Primavera Database. Note : Login Name, Password and ODBC DSN will be required for connecting to Primavera from Digital Project.

o

•

need to add toolbar to your Digital Project Workbench by o selecting menu item Views-> Toolbars->Primavera.

This toolbar has commands to Connect to Primavera Get Primavera Projects Get Primavera Activities Simulate Activities

Primavera SDK version 4.1 is currently certified for Digital Project. 130
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Connecting to Primavera

To establish connection to Primavera :
command from "Primavera" toolbar, 1. Select "Connect to Primavera" this action will pop-up "Login to Primavera" dialog box to enter connection information.

2. Enter your Primavera login name, password and ODBC DSN (ODBC Data

Source Name of Primavera Software Development Kit setup) in the dialog box.

Note : Contact your Primavera or System Administrator for login name, password and ODBC DSN to be used for Primavera or if your having trouble with login to Primavera.
3. Select "OK" button of ("Login to Primavera") dialog. 4. As long as the connection is establish the command remains active.
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Retrieving Primavera Projects

To retreive projects from primavera :
1. After connecting to Primavera, select "Get Primavera Projects" command from "Primavera" toolbar.

2. On selecting the command, the project structure (containing EPSEnterprise Project Structure and Projects) is retrieved from Primavera and corresponding tree structure Primavera Project Group is created. Note : If a project structure already exists then the project structure is synchronized with the current data in Primavera.
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3. At the end of the retrieval process of projects a dialog box is popped-up, read the message and select "OK".

Retrieving Primavera Activities

To retrieve activities of a project from Primavera :
1. After retrieving the project structure from Primavera select the leaf "Primavera Project" group whose activities are to be retrieved.
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2. Select "Get Primavera Activities" toolbar.

command from "Primavera"

3. This command will retrieve activities and WBS-Work Breakdown Structure (if exists) of "Primavera Project".

134

Advanced Tasks

4. At the end of the retrieval process a dialog box is popped-up read the message and select OK.

Linking Geometry to a Primavera Activity
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To link geometry of the project to activity :
1. Select the activity to which geometry is to be linked.

2. Pop-up the context menu by using right mouse button and then select "Activity Name Object-> Definition..." ,

this will pop-up a dialog box to edit the group.
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3. Specify "Visualize as" attribute ("Permanent"/Temporary") and select geometry to link to the activity. Permanent => The geometry component is visualized after the activity is complete. Temporary => The geometry component is not visualized after the activity is complete.
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Note : To remove a preexisting link to geometry, select the geometry item in the list box and select remove button.

Simulating Primavera Activities in 3D

To simulate primavera project activities in 3D :
• Activate the Primavera Project to be simulated. i.e., by selecting "Activate/Deactivate Group" context command on Primavera Project.
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•

Select "Simulate Activities"

command from "Primavera" toolbar,

this command will pop-up "Simulation" dialog box for setting the color and transparency information for geometry in "Not Start", "In Progress" and "Done" activity status.
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•

After setting the required colors for simulation, apply simulation by modifying the "Simulation Date". The simulation date can be modified by dragging the slider or scrolling the date using up/down arrow. While simulation date changes, the state of each geometry is computed and its color is updated as specified in the dialog box.
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Refer to the above snapshot and simulation dialog : o Red colored object inside the ellipse indicates that two or more activities are operate on (link to) the same geometry object and is "In Progress" state considering start date to be the earliest start date of the activities linked to the same geometry and end date to be the latest end date of the activities linked to the same geometry. Original (no/white color selected for "In Progress" state under permanent tab page of the dialog) colored object inside the white rectangle indicates that the permanent object is "In Progress" state. Green (selected for "Done" state under permanent tab page of the dialog) colored with transparency object inside the green rectangle indicates that the permanent object is "Done" state. Yellow (selected for "In Progress" state under temporary tab page of the dialog) colored object inside the yellow rectangle with round corners indicates that the temporary object is "In Progress" state.

o

o

o
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Filtering 3d Layers Using Colors
This task shows you how to color 3D geometry using layers.
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1. On the project Attributes Toolbar:

and then from

attribute

select the Color geometry base on layer

:

The Layer Filter dialog appears:
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2. Select one of the filtering value modes: Single or Range.

Select Single value if you target specific layer, otherwise select Range. 3. On each row, to associate layer with a color : • • • • Enter the layer value (or range of values). Select the highlight Color for the layer. Check the Hide check box instead if you wish to hide the geometries. If you want to include the geometries in the selection set, check the Select check box,.

4. Press the button to apply the filters.
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For more information about filtering, see Filtering Geometry Using Attributes. To view or edit a geometry's layers: • select the geometry. • right click and go to Properties -> Graphic -> Layers.

Create An Excel Data Sheet Template
Anatomy of an Excel Data Sheet Template.
An Excel Data Sheet template is an Excel sheet (.xls file) or an Excel template (.xlt file) which contains Digital Project Data Sheet export and upload instructions. Every Digital Project Excel Data Sheet template must contain the following essential elements:
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2. A unique first row. The first cell of this row is the initial cell and every other column of this row to the right of the first cell contains user defined reporting definition of that column.

3. A unique first column. The first cell of this column is the initial cell and it contains the mapping information between objects in Digital Project and the rows in the Excel Data Sheet. The content of this column is automatically updated by Digital Project and should not be edited by the user.
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4. Column reporting definition for each column. These reporting definitions reside on the first row and they comprise of a set of keywords defined in Digital Project. These keywords provide the instructions for data reporting and uploading. To see a complete list of keywords, see the section Keywords for data reporting below.

k e y w o r d s : F
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attributes e a t u r e N a m e , V o l u m e a n d G T C U n i f o r m . S M P U n i f o r m a t . D e t a i l
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E l e m e n t

keywords for data reporting.
Global instructions for the Excel Data Sheet appear on the unique initial cell. The content of this cell is a concatenation of individual instructions separated by a semicolon. Currently there are two global Datasheet keywords: 1. GT_MetaData, 2. INHERIT. The keyword GT_MetaData serves two functions: • • identifies the excel sheet as a Digital Project Excel Data Sheet, determines the location of the initial cell.

To report data inherited from an object's father or else its nearest ancestor, the INHERIT keyword is used. To export a package or group attribute we must supply three pieces of information: • the attribute name, • the package or group name, • the dictionary. We capture these information by concatenating the dictionary name, the package or group name and the attribute name into one string. Thus the keyword to identify the attribute Detail Element in the package SMPUniformat would be GTCUniformat.SMPUniformat.Detail Element where GTCUniformat is the dictionary in which SMPUniformat resides. In Digital Project, a Knowlegeware parameter of a User Defined Feature can be identified uniquely by its name. The keyword for a knowledgeware parameter is constructed in the similar way as an attribute's. To report a User Defined Feature's parameter named ParmName, the keyword syntax is: PARM.ParmName. Below is a complete list of keywords currently available in Digital Project.

keywords:

Reported
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InstanceName

NumberInstances

PartName

BodyOrSetName

FeatureName Volume Area Length CoordinateX CoordinateY CoordinateZ

data: Name of part instance the object belongs to. The number of instance of the object in the root product. The name of the part the object belongs to. The part body or the geometric set the object belongs to. The name of the object. Volume of a solid. Area of a surface. length of an edge. X coordinate of a point Y coordinate of a point Z coordinate of a point Group or package attribute. Composite keyword where: • XXX = dictiona ry name YYY = attribut e package or group name ZZZ = attribut

XXX.YYY.ZZZ •

•

150

Advanced Tasks

e name

PARM.XXX

Knowledgeware parameter. Composite keyword for User Defined Features where XXX is the parameter name.

Steps to create an Excel Data Sheet Template.
A. Create a Data Sheet template base on existing data sheet.
1. Create a Ad Hoc data sheet and select all data you wish to report. In the example below, we only report the Feature Name. Set the Data sheet name to the template name. Then click OK to create the Data Sheet.

2. Since we are creating a template, we don't need the Data Sheet feature in the master model, delete it.
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4. Add keyword to the columns you wish to report additional data. For example, PARM.WindowWidth for reporting User Defined Feature parameter WindowWidth.

5. Save the file either as an excel workbook (.xls file) or as an excel template (.xlt file) and the resultant file is ready to be used as a template.

B. Create a Data Sheet template from scratch.
1. Open an empty Excel workbook. 2. Choose a cell in the workbook as the initial cell by inputting GT_MetaData. Note that, once an Excel Data Sheet has been created from a template, the first cell may be modified but it can not be moved. Therefore, no column may be added to the left of the first column and no row may be added above the first row once the Data Sheet has been initialized.

152

Advanced Tasks

Note:

the initial cell is B3.

3. Add additional column definitions you wish to report data to the right of the initial cell. For example, add Volume for reporting volume of any solid and GTCUniofrmat.SMPUniformat.Detail Element for reporting the attribute Detail Element in the attribute package SMPUniofrmat in the dictionary GTCUniformat.

4. Save the workbook either as an excel workbook (.xls file) or as an excel template (.xlt file) and the resultant file is ready to be used as a template.

Data Sheet Reporting Format.
• The row immediately following the initial cell is reserved for presenting the unit of each column.
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attributes If there is no unit associated with the column, the cell corresponding to this column would be left blank. Each time an upload occurs, Digital Project reads the unit on the data sheet and uses it as the current operating unit during the upload. It then updates the units in the Excel Data Sheet with units from Digital Project. Therefore, A column's unit may be temporarily alter for data input and upload purposes.

• Read-only data are reported with a single value drop down list in Excel to safeguard it from being changed.
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• Formatting columns are allowed. Any column with a blank entry in the first row is ignored.

Note: Column C is a formatting column.

Transferring Attribute Packages
Attribute Transfer command transfers the attribute packages from the geometries of one Part (not the instance) to the corresponding geometries of another part by traversing through the tree structure of the parts. It works at the dictionary level, irrespective to the attribute package being selected. It is available only for product workbench.

This task shows you how to transfer attribute packages from one part to another.
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1. Select a dictionary, of which you wish to transfer the attribute packages, as the current dictionary.

2. Select the Attribute Transfer command through Data > Attributes Management Tools > Attribute Transfer.

3. Select a part from which you wish to transfer the current dictionary attribute packages. Note: Selection is restricted to part level.
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4. Select a part to which you wish to transfer the current dictionary attribute packages. The Attribute Transfer confirmation dialog appears...
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5. Click OK on the dialog to complete the transfer of attribute packages.

Digital Project doesn't consider two different geometrical parts with the same name to load in a single session. Hence, for the Attribute Transfer command to work effectively, it is mandatory to name the part files that are being considered to transfer the attribute packages, with different names before loading into the Digital Project session. Attribute packages are transferred according to the path and naming structure of the part sub-tree. For example, if xy plane, yz plane etc of OldPart (see steps 3 and 4) have attribute packages attached under MasterFormat, they would be transferred to xy plane, yz plane of NewPart respectively. For the sake of argument, if there is no object with the name of yz plane under NewPart, then except that all other objects under NewPart will acquire the attribute packages from OldPart respectively.
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Project Attributes Toolbar

First Dictionary: Selecting the Current Dictionary Dropdown Menu Second Group or Package: Selecting the Current Group or Package Dropdown Menu Group: Creating a Group Packages: Packages Toolbar Edit Attributes: Modifying Attributes Attribute Filters: Attribute Filters Toolbar Dim Mode: Turning Dim Mode On/Off

Packages Toolbar
Attach Package: Assigning Attribute Packages to geometry Paint Packages: Copying Attribute Packages Remove Packages: Removing Attribute Packages Microsoft Project Simulation: Microsoft Project Simulations

Attribute Filters Toolbar
Color by Attributes: Filtering Using Attributes
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Excel Data Sheets Toolbar

Excel Data Sheet: Creating an Excel Data Sheet Interactive Door Schedules: Generating an Interactive Door Schedule Interactive Window Schedules: Generating an Interactive Window Schedule

Construction Administration Toolbar

New Issue: Importing an Issue Form Update Issue Document: Updating an Issue Document Update 3D Issue: Updating an Issue from Document Change Create Response: Generating a Response
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Managing object and attribute dictionaries
Creating a Custom Attribute Dictionary
This task will detail how to create a custom attribute dictionary. Warning: Once a dictionary is in use, you should not use this process to update the dictionary, otherwise data would be lost. Follow the procedure outline in Extending Attribute Dictionaries to update a dictionary. Overview. Creating a custom dictionary has three stages: • • • define the custom dictionary in an appropriately formatted XML file, compile the XML file into a .CATfct file, place the generated .CATfct file in an appropriate location.

1. An attribute dictionary is a hierarchical organization of packages, groups and attributes. The attributes appear in packages or groups and the packages and groups appear in the dictionary. The entire dictionary, including definitions for packages, groups and attributes, is defined in an XML text document that you create. Review the following list of tags and keywords. These tags provide the requisite structure for an XML attribute dictionary definition. The <dictionary> tags surround the entire dictionary. <dictionary> appears at the beginning of the XML file, </dictionary> at the end. Each group definition must be enclosed by <group> and </group> tags. System identifier of a group. Must be unique. The super or father type of a group. It must

<dictionary> Dictionary Definition </dictionary>

<group> Group Definition </group>

<grouptype> Group Unique Identifier </grouptype>

<groupsupertype>Group's super type</groupsupertype>
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<grouproot> Root of a group </grouproot>

<displayname>Display name</displayname>

<package> Package Definition </package>

<pkgtype>Unique Package Identifier</pkgtype>

<pkgsupertype> Unique Package Identifier of Parent </pkgsupertype>

<pkgdisplayname> Package Display Name </pkgdisplayname>

be GTCAttGroup or any existing group type. the root of a group. If a group does not specify a group root, it will be inherit from its supertype. Displayname of a group or group root. Each attribute package must be surrounded by package start and end <package> </package> tags. The name used internally by Digital Project to refer to the Appears at the beginning of a <package> block. The package from which the current package inherits all of its attributes and organization. For a discussion of inheritance see step 2. The name for the package that will be displayed in the package drop-down menu The <attribute>

<attribute> Attribute Definition </attribute>
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tags surround the body of the attribute package definition. In the body appears with the attname tags <attname> </attname> Name of the attribute as it appears to the user and internally within Digital Project. optional. The default value of the attribute that appears in the add and edit dialogs. optional. Whether the particular attribute is read only or not. The value is either true or false. The type of the specified attribute. For example, String,

<attname> Attribute Name </attname>

<attdefaultvalue value=value>

<attreadonly> Boolean Value </attreadonly>

<atttype> Attribute Type </atttype>

Any KnowledgeWare type may appear as the type for a particular attribute, provided that the type name appears in all capitals. the following is a selection of frequently used KnowledgeWare types that may appear in custom attribute dictionaries.

String INTEGER BOOLEAN LENGTH MASS VOLUME

Alphanumeric Characters Standard integer type True/False Real with unit length Real with unit mass Real with unit volume
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AREA

Real with unit area

Here is a sample custom dictionary XML specification. It specifies: • • one package with three attributes, one group with two attributes.

2. Once you have reviewed the tag and keyword syntax for dictionaries, you must decide how the attributes, groups and packages that you wish to implement will be organized in the XML. The key thing to consider is that attribute dictionaries in Digital Project implement parent-child relationships and inheritance. This means that if one package (group) has a certain collection of attributes, you may define a second package (group) derived from the first package (group) that inherits those very same attributes. In addition, the second package (group) may have supplementary attributes that the first lacks. For example, consider this sample dictionary definition. The result appears in the dropdown as:

Notice that Sample Attribute Package 2 is indented from Sample Attribute Package. This means that Sample Attribute Package 2 is derived from and inherits all properties from Sample Attribute Package, and may add some of its own: Sample Attribute Package Sample Attribute Package 2

3. After creating the XML definition of the dictionary, launch Digital Project and go to either the Project Workbench or the Part Workbench. Activate the New Dictionary command: Data->Attributes Management Tools->New Dictionary.
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The following dialog is launched:

4. Select the XML file created in step 2 and the .CATfct file you wish to create and click OK. A confirmation dialog will appear once the dictionary is generated.

Click OK to completed the .CATfct creation process.
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attributes 5. After the dictionary is compiled to a .CATfct file, you must place the resulting .CATfct file in the subdirectory "\startup\Dictionaries" of the project standard installation. For each new attribute package PkgName, a corresponding .CATRsc file is also generated in the folder msgcatalog in the directory where the new .CATfct resides. Move all the new .CATRsc files to the foler "\startup\Dicationaries\msgCatalog" of the project standard installation. Your custom dictionary is now ready for use.

Extending Attribute Dictionaries
This task will demonstrate how to edit an existing attribute dictionary. An attribute dictionary may modified by: • • • • • adding new packages, adding new groups, adding new attributes to existing packages or groups, removing attributes of a group or package, editing existing attributes.

Prerequisites. • • • Familarity with attributes Understanding of XML Ability to create new attribute dictionaries.

Overview. In order to modify an existing attribute dictionary, you must first create an XML definition, then compile this XML update the .catfct using Digital Project's Attributes Management Tools.

1. Create a new XML text file using any text editor. This XML file is similar to the one used for the creation of the original dictionary with a few distinctions. The following table outlines the syntax of an XML file used for editing dictionaries. <dictionary> <newpackage> <editpackage> <newgroup> <editgroup> <removeattribute> <newattribute> Dictionary tags always wrap the XML file. Every new package must be wrapped in <newpackage> tags. Change the displayname or attributes of an existinig attribute package. Create a new group. Edit a group. Remove an existing attribute. Create a new attribute, either in an edited or a new package or group.

For example, consider the following XML dictionary definition used to create a new attribute
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We modify the dictionary by creating another XML dictionary definition file. This file codifies instruction to: • • • • • add new package: SMPRoomPkg, add attributes--Room Number,Capacity,Room Finish--to the package SMPRoomPkg, add attribute Capacity to the package SMPFloorPkg, remove attribute Floor Finish from the package SMPFloorPkg, added new group: SMPGroupSample and give this group attribute Group Number.

2. Suppose that the dictionary containing SMPFloorPkg has been created. After saving the second XML file in step 1, launch Digital Project and go to either the Project Workbench or the Part Workbench. Activate the Edit Dictionary command: Data->Attributes Management Tools->Ed Dictionary.

The following dialog is launched:
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3. Select the XML file created in step 1 and the .CATfct file you wish to update and click OK. A confirmation dialog will appear once the dictionary update is completed.

Click OK to complete the process. 4. Since we created a new package during the modification of the dictionary, the file SMPRoomPkg.CATRsc is created for the new package SMPRoomPkg. The new .CATRsc file is created in the subdirectory msgCatalog of the folder containing the .CATfct file. Move the new .CATRsc file to the subfolder "\startup\Dictionaries\msgCatalog" of the project standard installation.

Exporting Attribute Dictionary

This task shows how to export an attribute dictionary to a xml file.
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1. Selection the dictionary you wish to export as the current dictionary. For detail about selecting the current dictionary, see Selecting the Current Dictionary. In this example, we will export the dictionary GTCUniformat.

2. Go to the Project or Geometry workbench. Activate the export attribute dictionary command by going to: Data->Attributes Management Tools->Export Dictionary.

The following dialog is presented:
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3. Choose the directory and the xml file name you want export to, then click OK.

4. Click OK on the confirmation dialog to complete the export process.

Adding and Modifying Discrete Values for Attributes
The task shows how to modify the discrete values that appear in the drop-down menus for some attributes.

Prerequisites. • • Familiarity with attributes Ability to create and edit simple text files
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Overview. Many attributes have a discrete list of possible values from which a user should choose. For example, an administrator may restrict the possible choices for Uniformat detail number, Masterformat detail, door material, review status, or reviewer. An attribute DiscreteAttribute is discrete if there exists a file \Dictionaries\Dictionary Name\AttributePackage Name\DiscreteValues\DiscreteAttribute.txt in the project standard installation, where Attributepakcage Name is either a package containing the attribute DiscreteAttribute or a package that is an ancestor of the package containing the attribute DiscreteAttribute. 1. Suppose we want to modify the discrete value list of the attribute Detail Element in the package SMPUniformatBasementWalls. The package SMPUniformatBasementWalls resides in the dictionary GTCUniformat. We locate the Detail Element.tex in project standard. If the Detail Element.txt does not exists, create it in the directory mentioned in the overview.

2. Each discrete value corresponds to a line entry in the file Detail Element.txt. Modify the content of the discrete list by modifying the file Detail Element.txt.
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Attribute package names are found in the XML definitions of attribute package dictionaries. For more information see Creating a Custom Attribute Dictionary. For the package definitions shipped standard with Digital Project, see Standard XML Attribute Dictionary Definitions.

Sharing Discrete Values

The task shows how to access shared discrete values.

Prerequisites. • • Familiarity with attributes Ability to create and edit simple text files

Overview. Many attributes have a discrete list of possible values in common with other attributes These sharable lists are gather under one folder and they are accessing from individual attribute u a redirection directive. The shared lists are placed in the folder \dictionaries\shared in the Proj Standard installation directory.
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1. Suppose we want the attribute Assigned To in the package SMPDesignChange to use the dis list in the shared file engineers.txt. We first create the file Assigned To.txt as detailed in Addin and Modifying Discrete Values for Attributes.
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2. Enter the line: <engineers.txt in Assigned To.txt. Now the attribute Assigned To is sharing the discrete values in the file engineers.txt.

Using Measure Formulas in Dictionaries
Custom dictionaries provide a way to extend the functionality of the basic dictionaries shipped with Digital Project. Custom dictionaries also allow the user to add Measure Formulas to attribute packages. These measure formulas allow direct takeoffs, such as length, area, or volume, to appear as attribute values. This task shows you how to create and use a dictionary with measure formulas. 178
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Prerequisites. • • • Familiarity with XML Ability to create and edit attribute dictionaries Understanding of attributes and attribute toolbars

1. Open the XML definition of the dictionary to which you wish to add measure formulas in a text editor. If you do not have an XML definition for the dictionary or you would like an introduction to creating custom dictionaries, see Creating a Custom Attribute Dictionary. 2. A measure formula is simply an attribute with a specific atttype. By specifying the proper atttype, the attribute will automatically check the attributed geometry and provide, as the value, the length, area or volume of this geometry. The following table lists the types of measure formulas that may be added to a custom attribute dictionary.

atttype: LENGTH AREA VOLUME

May be applied to: Wireframes, curves, and lines Surfaces (but not solids; does not provide wet area) Solids

Here is a sample dictionary appropriately uses all measure formulas. This dictionary has three packages each has a measure as an attribute. A measure formula attribute must always be read only. Also, in Digital Project, only one attribute formula per package is allowed, although many may reside in the same dictionary.

3. After saving the XML, complete the dictionary creation by compiling the XML to .catfct and placing this resultant .catfct file in the appropriate directory. For more on this process see Extending Existing Attribute Dictionaries and Creating New Attribute Dictionaries in the Project Standards section of this book.

4. Load Digital Project. In the Project Attributes toolbar,

your sample measure dictionary will appear.
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If you select a measure package, for example Element Volume, and add it to a building element, the measure appears in the attribute package dialog.

Associating icon to a group.
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1. Determine the group type of the group. The group type is enclosed by the <grouptype> tag in the XML dictionary definition file. See Exporting Attribute Dictionary for detail of create the XML file from an existing dictionary.

2. Create a bitmap of size 22x22 pixels, and name it group type.bmp.

3. Move the bitmap file to the subdirectory \startup\Dictionaries\icons of the project standard installation directory.

If the custom icon was not specified, the subtype will inherit the icon from the nearest ancestor super type which has a custom icon assigned.
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Associating statuses to a group

Any group with a discrete value attribute may be associated with it status masking icons. The task shows how to associate status icons to group.

1. Locate the directory DiscreteValues for the group attribute in question. For this example, it w be Issue Status attribute in the group SMPConstIssue. Create the directory StatusFlags in the same folder that DiscreteValues resides. Note that there could only be one attribute in a group serves as the status flag attribute.
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2. Copy the file Issue Status.txt from the directory DiscreteValus to the folder StatusFlags.

3. Change the content of Issue Status.txt which is an exact copy of the discrete value list from: Resolved Unresolved to Resolved,I_GTCMaskgreen Unresolved,I_GTCMaskred The file Issue Status.txt in StatusFlags now associates the discrete value Resolve with the status icon I_GTCMaskgreen and Unresolved with I_GTCMaskred.
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Define an attribute as a hyperlink.
The task shows how to define an attribute typed as a hyperlink in the dictionary.

Prerequisites. • Familiarity with attributes.

Overview. A hyperlink attribute provides the ability to open a document associated to the attribute. The hyperlink property is defined in the dictionary.
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1. Choose the attribute you want to be a hyperlink, say Attachment in the group SMPDesignChange.

2. Create the empty file Directionaries\GTCDesignCollaboration\SMPDesignChange\hyperlinks\Attachment.txt in the project standard's installation directory, where GTCDesignCollaboration is the dictionary in which the group SMPDesignChange resides. The existence of the file Attachment.txt in the hyperlinks folder indicates to Digital Project that the attachment attribute is a hyperlink attribute.

For more information about using hyper links, see Using HyperLinks.
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Defining attributes as links to paragraphs of a document.
The task shows how to link an attribute to a paragraph in Microsoft Word document.

Prerequisites. • Familiarity with attributes

Overview. A hyperlink attribute provides the ability to open a document at the paragraph associated to the attribute.

1. Choose an attribute say, Attachment in group SMPDesignChange, to be a hyperlink attribute

186

Project Standards

2. Create the file Directionaries\GTCDesignCollaboration\SMPDesignChange\hyperlinks\Attachment.txt i project standard's installation directory, where GTCDesignCollaboration is the dictionary in whic group SMPDesignChange resides.
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attributes 2. A hyperlink has two components: the base and the link. The base is specified in the file Attachment.txt. A sample of the file Attachment.txt is given below:

Once the file Attachment.txt has been saved, all Attachment attributes are linked to the Word document M:\projects\Arena\Design Docs\Uniformat.doc. Instead of a file in a local file sys a web site may be specified in the Attachment.txt. In that case we would have:

The link is usually a specific bookmark or a HTML page and it is specified as a group attribute value, see Creating links to paragraphs of a document. for details.

Defining Standard XML Attribute Files
The following files are the XML definitions for the standard dictionaries delivered with Digital Project. Copies of them are in the samples directory.

Dictionary GTCAttBasePackages.xml GTCMasterFormat.xml GTCMicrosoftProject.xml GTCSchedules.xml

Purpose of the Dictionary Base from which all other packages or groups are derived For adding Masterformat (CSI) attributes Coordinates with Microsoft Project. Door and Window schedules
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GTCConstructionAdministration.xml Group definition for construction issue and response GTCDesignCollaboration.xml GTCUnspecifiedGroups.xml Group definition for design collaboration Group definition for a generic grouping group

Managing impacts of dictionary changes

This task shows how to maintain model consistency in the event of dictionary changes.

Overview. In order for many attribute functions to work properly after attribute dictionaries have changed, the differences between attached attribute packages and the changed attribute packages in dictionaries must be reconciled. Digital Project provides a tool that will: • • remove an attribute from an attached package if this attribute is no longer defined in the dictionary's package, add an attribute to an object's attached package if it is not present in the attached package but it is defined in the dictionary's package.

1. Start the synchronization process by selecting the Data->Attributes Management Tool>Synchronize Attributes command.
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A report of possible conflicts and conflict resolutions is presented:
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2. Click OK on the report dialog to complete the synchronization process.

If there is no conflict between attached packages and packages in dictionaries, the user is presented with the following dialog:
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Customizing reports
Customizing Door and Window Schedules

This task will demonstrate how to customize door and window schedules.

Prerequisites. • • • Familiarity with attributes Understanding of Excel Knowledge of Visual Basic fundamentals

Overview. The appearance of door and window schedules depends on both the Visual Basic application that generates them and the specific Excel template that this Visual Basic application loads. This task shows how to modify these applications and templates.

1. First, launch Microsoft Excel.
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2. In the File -> Open dialog, open the door or window schedule template. These templates reside in the DoorSchedule or WindowSchedule directories within DigitalProjectInstallDirectory/intel_a/VBScript/.

The basic appearance of the Door or Window schedule can be modified directly in the template. For example, you may choose to modify the font types, font sizes, or line
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attributes weights for the schedule. As long as the schedule is not re-arranged, the schedule function will work properly. In order to change the arrangement of information (that is, to report door thicknesses to column G instead of column D) you must modify the Visual Basic application that generates the schedule (see step 2).

3. Once you have modified the templates, be sure you save them back into the same directory. By default, these files are read only. In order to overwrite them, right click on the file in Windows explorer and select properties. In the properties dialog, uncheck Read-only.

You should now be able to save the template properly.
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Project Standards 4. Now you will modify the Visual Basic application that generates the door schedules. Before you do, you should make sure that the VBA scripts (.catvba files) are not read only by opening their properties windows. Digital Project includes Visual Basic for Applications, a development environment designed specifically for creating applications that enhance the functionality of Digital Project. The door and window schedules, as well as the built-in cost estimation function, were created in Visual Basic for Applications. This allows you to edit these applications with the Visual Basic editor integrated into Digital Project. Before you edit a VBA application, you must add the application to the list of active macros. To add a VBA application to the list of active macros, first open the macro window by selecting Tools -> Macros.

195

attributes

In the Macros window, select Macro libraries.

In the Macro Libraries window, make sure VBA projects is selected under Library type and click Add existing library. In this dialog box you may select the VBA applications you want to edit. You will find the door and window schedules in the DoorSchedule or WindowSchedule directories within DigitalProjectInstallDirectory/intel_a/VBScript/

After adding the VBA applications, click close in Macro Libraries and close in Macros. You are now ready to edit the door and window schedule applications.
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You may see a dialog box like the following:

Select No and proceed.
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Above is a screenshot of the Visual Basic editor. The left column lists all of the open VBA applications that you opened in the Macro Libraries window. The right window shows the current VB code, in this case the code for Door Schedules. In the left column, expand the tree under the application that you plan to modify, and doubleclick on the code icon one. in the modules folder to make this application the current

If the left column is blank, return to step 4 to load at least one VBA application.

6. Now that you have opened the VBA editor, you can directly modify the door or window schedule. Both the door and window schedule applications have similar structures. The top of the file includes variable and constant declarations that should not be modified. Scroll down to the section of the file labeled BEGIN USER MODIFIABLE.

198

Project Standards

The code for formatting and populating the spreadsheet is within this section. There are two functions in this section that report different information. The first function, ReportDoors (or ReportWindows) places information from the attribute package into the Excel spreadsheet. Two lines of code are necessary for this: one get the information from the attribute and one to place it in the Excel sheet. Below is the anatomy of this code.

Package Name

Attribute Name Row Number Column Number

The attribute package that contains the reported attribute. This name is specified in the XML attribute dictionary definition (see Creating Custom Attribute Dictionaries for more information). For door schedules, this is always "SMPScheduleDoor"; for windows schedules it is always "SMPScheduleWindow". The name of the reported attribute. This name is specified in the XML attribute dictionary definition and also appears when the attribute package is edited within Digital Project. The row number in the Excel spreadsheet where the particular attribute will be reported. The column number in the Excel spreadsheet where the particular attribute will be reported.

The second function reports parameters that are attached directly to the door or window geometry and appear in the specification tree. For example, the door height may

Parameter Name Row Number

Column Number

The parameter name as it appears in the specification tree under the parameters list. The row number in the Excel spreadsheet where the particular parameter will be reported. The column number in the Excel spreadsheet where the particular parameter will be reported.
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In general, you should not modify the package name or attribute name unless you are planning to extend the reporting to a custom attribute package, which is beyond the scope of this file. You may modify the row number or column number to report to the proper location in your modified excel file, or customize what is reported to that cell by assigning an altogether different value to the cell. 7. After you have modified the VBA application, click the save button and exit. This will overwrite the original door or window schedule with your new, modified schedule.

Extending the Microsoft Project Integration Schema
This task explains how to extend the Microsoft Project integration schema.

Prerequisites. • • • • Familiarity with XML Facility with Microsoft Project Understanding of basic attribute manipulation (adding, removing, editing) Ability to create custom attribute dictionaries

Overview. Digital Project provides links to Microsoft Project with special Microsoft Project attributes. You can extend the basic functionality of these attributes by creating new dictionaries that take advantage of additional Microsoft Project task fields. This task shows you the XML syntax required to create a Microsoft Project dictionary.
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Project Standards 1. Create a new XML file. Each package in this file should derive from GTCMppTask, which indicates that Digital Project uses these attribute packages to coordinate with Microsoft Project. For example, consider the following dictionary definition. <?xml version="1.0"?> <dictionary> <package> <pkgtype>ProjectMasterTimeline</pkgtype> <pkgsupertype>GTCMppTask</pkgsupertype> <pkgdisplayname>ProjectMasterTimeline</pkgdisplayname> <attribute> <attname>Baseline Start</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Baseline Finish</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Deadline</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Actual Cost</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Actual Duration</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> <attribute> <attname>Critical</attname> <atttype>String</atttype> <attreadonly>true</attreadonly> </attribute> </package> </dictionary>

Note that the following are Microsoft Project task fields • • • • Baseline Start Baseline Finish Deadline Actual Cost
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When this dictionary is compiled, Digital Project uses these Microsoft Project fields and will populate them from the MPP file name specified in <pkgtype>. In this example, all of the information populating these attributes will come from ProjectMasterTimeline.MPP.

2. After you have created your XML file, compile it to a .catfct file and put it in the appropriate directory. For more information, see Creating Custom Attribute Dictionaries.

3. The compiled dictionary will give you access to your extended Microsoft Project schema.

For a complete list of Microsoft task fields see Microsoft Project Task fields.
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